Using Excel to
Troubleshoot EMIS Data
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The Ohio Department of Education funds development of EMIS training materials
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these
materials in training provided to your districts. That said, there are restrictions on
use of the EMIS Alliance materials as follows: Materials developed as part of the
EMIS Alliance program must be provided at no cost to your training participants. If
you utilize the EMIS Alliance training materials — in whole or in part — you must not
charge participants a fee to attend the class where the materials are used. Likewise,
you may not use the materials or any portion thereof in any event where a fee is
charged to attend. Exceptions must be approved in writing by the Department of
Education in advance of scheduling/promoting any event which may violate these
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for
exception to the restrictions noted above, should be directed to Melissa Hennon
[Melissa.Hennon@education.ohio.gov].
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Overview

* Basic Excel techniques can be used to analyze EMIS data
from Student Information Systems (SISs), from the Data
Collector, and on ODE EMIS reports

* This session will demonstrate Excel functions and practical
applications that can be helpful in all phases of the EMIS
data review process

EMIS

N
Alliance

= 3

|

Outline

* Simple formulas to troubleshoot student FTEs
* VLOOKUP to add LEA names to a report
* Macro to format an FTE Detail report

* Concatenation and conditional formatting to verify
calendar data and student data
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Use Simple Formulas to
Troubleshoot Student FTEs

—— —————

Simple Formulas

| *In this section we are going to use simple formulas to
| identify differences between

\ * Original FTEs and Adjusted FTEs

) * Adjusted FTEs and Special Education Adjusted FTEs

* We will filter and highlight those differences to aid in
troubleshooting the FTE Detail report
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" FTE Detall Report

' Open the most recent version of the FTE Detail Report

LI BE
INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

2

\ T &H
HOME
X Cut

=¥ Wrap Text General

Do not format/prepare the report | =veseaceoe - 5%

1. Add two new columns
. | by selecting column S

+% 1 and column T, then right
" | click and select “Insert”

I v. A
u
Cut

Paste Options:

|

Clipboard ) Font Alignment r Number
s1 fe || LEGALDIST OF RESIRN
B
G H 1 ) K L M N o P Q R | S T
1 |First NamiMiddle N¢LEA IRN  LEVEL 2 RERESULT CCRESULT CCFTE FUND ENRL STAFENRL END ORIG FTE ADJSTD F1ADJSTD SHLEGAL DIS|ST
2 [First  Middle 011506 FTED-001 FT0000 FTEDetail STEM  07/01/20112/31/250 1 1 044180 By Cop
3 |First Middle 011506 FTED.ON1 STOONN ETC Datail STCAA ners/rn1 m/oe/In1 0 AQ1779 0.491228 044180
4 |rirst  Middle 000236 FTH . 1 044130
5 |First  Middle 000577  FTH 2. Drag to Wlden, then name 1 044180
6 [rist  Middle 000297 FTH 1 0.6{044180
Tliem wiae wsssr o the two new columns R
8 |First Middle 045054 FTED-OUT FTUUUU FTE D@l OPDD ——US5/2Z8/ 20T 127317250 U.UBUSS ™ 0.045088 044180
9 [First  Middle 000241  FTED-001 FTO000 FTE Detail COMM  07/01/20112/31/250 1 1 044180
105/30/201 1 1 044180
Q R U 101/06/201 0430798 0.387564 0.387564|044180
112/31/250 1 1 044180
ADJSTD FTADJSTRSFORIGvs ADJ ADJ vs Sp Ed GAL DIS STO10s/31/201 0.92 0.92 044180
\ 1 044180 112/31/250 1 1 044130
1 06/30/201 1 1 044180
B 0.491228 044180
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Add Simple Formulas
' Subtract ADJSTD FTE from ORIG FTE

In cell S2 type an equal sign
then click into cell P2. Type
a minus sign. Click into cell Q2

R S T
FORIG vs ADJ vs Sp Ed

Double click, or click and drag the
bottom right corner of cell S2 to
populate the cells below

T L~

=P2-Q2
and press enter
K L M N o) P Q
2 RERESULT CCRESULT CC FTE FUND ENRL STAFENRL END ORIG FTE ADJSTD F1ADISTD §
001 FTO000  FTE Detail STEM  07/01/20112/31/250 1 1i
1001 FTO000  FTE Detail STEM  08/15/20101/06/201 0.491228 0.491228
1001 FT0000  FTE Detail COMM  08/27/20105/31/201 1 1
=P2-Q2
K L M N o P Q R S
L 2 RERESULT CCRESULT CC FTE FUND ENRL STAFENRL END ORIG FTE ADJSTD FTADJSTD SFORIG vs ADJ AD)
-001 FTO000  FTE Detail STEM  07/01/20112/31/250 1 1
-001 FT0000 FTE Detail STEM  08/15/20101/06/201 0.491228 0.491228
001 |FT r tant tas

Here we can see if there is a difference /

between the original and adjusted FTE
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~ Add Simple Formulas, cont’d
' Subtract ADJSTD SPECED from ADJSTD FTE

1. In cell T2 type an equal sign
then click into cell Q2. Type

=Q2-R2

K

-001 FT0000
-001 FT0000
-001 FT0000

L M
FTE Detail STEM
FTE Detail STEM
FTE Detail COMM

N 0o
07/01/201 12/31/250

08/27/201 05/31/201

P

1

L 2 RERESULT CCRESULT CCFTE FUND ENRL STAFENRL END ORIG FTE _ADJSTD FT_
3
08/15/20101/06/201 0.491228 0.491228

Q R

1)

1

ADJSTD SFORIG vs ADJ ADJ vs Sp Ed
Dl:..--.. ,E ‘I

a minus sign. Click into cell R2
and press enter

T /

S

2. Double click, or click and drag

special ed

ucation FTE

Here we can see if there is a difference
between the adjusted FTE and adjusted

-001 FT0000
-001 FT0000
-001 FT0000

L04_CTOOO0

FTE Detail STEM
FTE Detail STEM
FTE Detail COMM

LI Dadail £S04

07/01/201 12/31/250

1

L 2 RERESULT CCRESULT CCFTE FUND ENRL STAFENRL END ORIG FTE ADJSTD FTADJS

1

08/15/20101/06/201 0.491228 0.491228

08/27/20105/31/201

ooliafans aniaslaco

1

2

1

1

the bottom right corner of cell
S2 to populate the cells below

S T
ORIG vs ADJ ADJvs Sp Ed

1

0.491228
\ 5
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~ Filter and Highlight ORIG vs ADJ Data
|
|
_ .
| Ho ¢ Lzoe®- From the Data tab, add filters
\ GO HOME  INSERT  pAGELAYOUT  FoRmuLas (T DATA ) REVIEW
L=l Connectiome 4 H Cl
ey 3 & [ o0
- operties Ve
From From From From Other Existing Refresh il Sort
4 . A s
Access Web Text Sourcesw  Connections  All~- Edit Links 7 Ad
s Get External Data Connedions
H 1 ] K L M N o [ Q R s R
1 |Middle = |LEA IRN ~ | LEVEL 2 = |RESULT ~ | RESULT ~ | FTE FUI = | ENRL ST~ |ENRL EI ~ | ORIG F1 ~ | ADJSTC ~ | ADJSTE ~ | ORIG vs AL ~ F|Iter on Column S’
2 Middle 011506 FTED-001 FT0000 FTE Detail STEM  07/01/20112/31/250 %] llest to Largest
3 Middle 011506 FTED-001 FT0000  FTE Detail STEM 08/15/20101/06/201 3 to «“ ”
4 Middle 000236 FTED-001 FT0000 FTE Detail COMM  08/27/20105/31/201 ORIG Vs ADJ ’ unseIeCt
5 Middle 000577 FTED-001 FT0000  FTE Detail COMM  08/13/20112/31/250 unn .
6 |Middle 009957 FTED-001 FT000 FTE Detail COMM  07/01/20112/31/250 0 al‘ld C|ICk OK
7 Middle 045054 FTED-001 FT000 FTEDetall OPDD  05/28/20112/31/250
8 |Middle 000241  FTED-001 FTO000  FTE Detail COMM  07/01/20112/31/250
9 |Middle 052878 FTED-001 FT0000  FTE Detail JPSN 08/20/20105/30/201
10 Middle 009957 FTED-001 FTCO0D  FTE Detall COMM  07/01/20112/31/250
11 Middle 054239 FTED-001 FTO000 FTEDetall /SN 09/19/20105/31/201
12 Middle 046128 FTED-001 FTO000 FTEDetall OPDD  08/15/20112/31/250
13 |Middle 052803 FTED-001 FT0000 FTEDetail JPSN  07/01/20106/30/201 10001085
14 Middle 044180 FTED-001 FT0000 FTEDetallRGIV  07/01/20112/31/250 10002222
15 Middle 044180 FTED-001 FTQ000 FTEDetallRG)V  07/01/20112/31/250 :ggg‘:;
16 Middle 044180 FTED-001 FT0000 FTEDetallRGIV  07/01/20112/31/250 sy
17 Middle 044180  FTED-001 FT0000 FTE Detall PSRD  07/01/20112/31/250 10213682
18 Middle 044180 FTED-001 FTO000 FTEDetall PSRD  07/01/201 11/08/201 10.247754
19 Middle 044180 FTED-001 FT0000 FTEDetall PSRD  11/07/20112/31/250 z
20 Middle 024180 FTED-001 FT0000 FTE Detall PSRD  03/04/20105/23/201 [ conca ]
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I. Filter and Highlight ORIG vs ADJ Data, cont’d

B H - T8 9: I
;113 HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
k Cut Calibri T = - B WopTet " = E Zi | normal Bad
ER Copy -
S romuriinie | B 1 U -4 == Bwsccne - 5| Salect cells in column S “ORIG vs ADJ”,
AT right click and highlight in yellow
H 1 J K L M N o P Q R s / U
1 |Middle ~ LEA IRN ~ |LEVEL2 ~ RESULT ~ | RESULT ~ |FTE FUf ¥ [ENRLST ~ ENRLEI ~ | ORIG F1 * ADJSTC * ADISTC * |ORIGvs AC.T ADJvs SpE ™ LEGALL -~ STONT ~ |SENTH
17 Middle 044180 FTED-001 FTO000 FTE Detail PSRD 07/01/201 12/31/250 1 0.465974 0.387956 0.5340%6 NN7RNMK NAA1RN s
0.465974 0.387982 0.077¢ Calibi  ~(11 ~/ A" a" § = ' B
Note that the appearance of l os R - SERE R
- 2 Jors
IE-06 happens when the L oauen oGS 03 iy gpmmmEmE
0.461538 0.247856 0.147943 0.213682 0.0¢
difference is 0.000001. This o27068] 0.579934] varsues QRO 02! |"
. 0.180451 0.150376 0.150376 0.030075 n II I III
0.296673 0.286672 0.010001 0.2f Standard Colo
can be correCted by formattlng 0.374299 0.373211 0.0 0.3'..'.‘ B J;-.--
the column to be “Custom” with |; e =
0.295455 0.293233 0.293233 0.002222 TR et -
a value of “0.000000” 1 [] 1 0044180 100 -
1 0 1 0 044180 100 -
268
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- Filter and Highlight ADJ vs Sp Ed Data

| .
WEHS ¢ mZew: From the Data tab, clear filters
FILE HOME INSERT PAGE LAYOUT FORMULAS REVIEW VIEW
B N y (&) Connections 713 B
B le < ") Alz s
from Ffrom From FromOther  xisting  Refresh Sot | [lENE
Access Web Ted Sources~ Connections  All- o V- Advanced
Get External Data annection: Sort & Filter
. .
" : ; " . . —— . |Selectfilter in column
([ADISTE ~ | ORIG vs AC ~ | AD) vs Sp € + | LEGAL £~ | STONT |~ | SENT R{ = | SENT Ri ~ |SENT R{ ~ | SENTR(~ smrsznscs P »”
1044180 %0 Ps 10 1 . DISAB CNDTN CODE )
0 0.491228 044180 100 - -
0 towi 0 of unselect “**” and “(Blanks)”
[ 1048180 100 -
o 1 044180 100 - . “ ”
T then click “OK
o 1 044180 100 - =
) 1 048180 100 - : =2
0 1 044180 100 - == =
0 0.92 044180 100 - " Segaiy 2
[ 1044180 100 - = .
0 1044180 100 - ~o3 2
0 1044180 100 - 05 .
0 1 044180 100 - s 3
1 0 0 044180 100 - w10 1
0387956 0534026  0.078018 044180 50 - @12 5
0.254876 0 0091278 044180 50 - 21 6
0.676692 0 0 044180 50 - = i: 2
0.278195 0 0045113 044180 50 - T 2
0 0027839 048736 50 - .
0077992 0.387982 048736 50 - —
1 v 0 044180 50 - — EMIS
- "’ 31 D]
5
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- Filter and

Highlight ADJ vs Sp

Ed Data, cont’d
—

Apply a second filter on column
T, “ADJ vs Sp Ed”, then unselect
“0”, and click “OK”

LIS hxE e e
FILE HOME  INSERT  PAGELAYOUT ~ FORMULAS = DATA | REVIEW  VIEW
Y y ™Y ™ B [ [ Connections Y Clear
& Il & = |
|| B ls LB L& = Les . V. Reapply
From From From FromOther  Bxisting  Refresh Text to
Access Web Tet Sources~ Connections All- Ve Advanced  Colymns
Get External Data Connedtions Sort & Filter
AB1 = fe | DisaBcNDTN CODE
|
| H 1 J K L M N o P Q R

S

Alliance

1 [middie - |LEA IRN ~ | LEVEL 2 - | RESULT = |RESULT, - | FTE FUT = | ENRL ST~ |ENRLET - | ORIG Fi ~ | ADJSTE ~ | ADISTE » | ORIG vs AT
16 Middle 044180 FTED-001 FTO000 FTE Detail RGIV 07/01/20112/31/250 1 Sort Smallest to Largest
17 Middle 044180 FTED-001 FTO000 FTEDetail PSRD  07/01/20112/31/250 1 Sart Largest to Smallst
18 Middle 044180 FTED-001 FT0000 FTEDetall PSRD  07/01/20111/08/201 0.346154 e
19 Middle 044180 FTED-001 FT0000 FTEDetall PSRD  11/07/20112/31/250 0.676692 -
20 Middle 044180 FTED-001 FT0000 FTE Detail PSRD  03/04/20105/23/201 0.323308
23 Middle 044180 FTED-001 FT0000 FTE Detail PSRD 07/01/20112/31/250 1
27 Middle 044180  FTED-001 FTO000 FTE Detall PSRD  03/13/20112/31/250 0.284615 0.21  Number Filters v
31 Middle 044180 FTED-001 FT0000 FTEDetail PSRD  07/01/20112/31/250 1 =
32 Middle 044180 FTED-001 FT0000 FTE Detall PSRD  12/17/20104/10/201 0.360902 0.3( — #
33 Middle 044180 FTED-001 FT0000 FTEDetail PSRD  01/08/20112/31/250 0511278 0.5 2
37 Middle 044180 FTED-001 FTO000 FTEDetail PSRD  04/11/20112/31/250 0.180451 0.1f Z0.045113
38 Middle 044180 FTED-001 FTO000 FTEDetail PSRD  02/25/20104/10/201 0.172932 0.1 Wi0073453
39 Middle 044130 FTED-001 FT0000 FTE Detall PSRD  07/01/20105/06/201 0.923077 0.5i Foo7s018 5
40 Middle 044180  FTED-001 FT0000 FTEDetall PSRD  05/07/20112/31/250 0.076923 0.0 = e
41 Middle 044130 FTED-001 FT0000 FTEDetall PSRD  07/01/20112/13/201 0.461538 0.2¢ =
42 Middle 044130  FTED-001 FTO000 FTEDetall PSRD  12/14/20112/31/250 0.538462 0.5i #0.162054
43 Middle 044180 FTED-001 FT0000 FTE Detail PSRD  07/01/20112/31/250 1 Fo62516 s
46 Middle 044180 FTED-001 FTO000 FTEDetail PSRD  07/01/20112/31/250 1
47 Middle 044180  FTED-001 FT0000 FTEDetall PSRD  12/10/20112/31/250 0.571429 0.5]
49 Middle 044180 FTED-001 FT0000 FTEDetall PSNR  10/08/20105/08/201 0.729323 0.7: ,EMLS‘_ -
I
Alliance
1
Filt d Highlight ADJ vs Sp Ed Dat t'd
- rlter an I I VS dala, con
| gniig P ,
I
[ R >3 9 9: Mo DT
| HOME  INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW
[ Yy T, (&) Connections  »| [ZTR| Clear LeY =] 1
2 $ = oOF MY @ 5 ?
:ram F:‘ov: Flr:: Fr;’momev . bm\:\g R:!:Iech z, Sot [ i‘lﬂd"mm‘ CT?no DRe:n . R
ccess We urces=  Connections . olumns uplica
| Select cells in column T, right
. N . N N
| - Ji || anraw click and highlight in green
H 1 J K L M N [+] P Q R S L u v w X
1 Middle = |LEA IRN ~ | LEVEL 2 ~ |RESULT » | RESULT, = | FTE FUF = | ENRL S1 ~ | ENRLEI ~ | ORIG F » | ADJSTC ~ |ADJSTE ~ | ORIG vs AL ~ | ADJ vs Sp E-¥| LEGAL [ ~ | STONT |~ |SENT Ri | SENTR{ = /5|
17 Middle 044180 FTED-001 FT0000 FTEDetail PSRD  07/01/20112/31/250 1 0465974 0387956  0.534026 01078018 042180 50.- .
18 Middle 043180 FTED.001 FT0000 FTEDetall PSRD  07/01/20111/08/201 0.346154 0.336154 0.254876 o 01091278 042180 50 .
20 Middle 044180 FTED.001 FTO000 FTEDetail PSRD  03/04/20105/23/201 0.323308 0.323308 0.278195 0 0.085113 044180 50. X
32 Middle 044180  FTED-001 FTO000 FTEDetall PSRD  12/17/20104/10/201 0.360302 0.360902 0.249763 of o_.u‘l Caibi <[ <A A S % s
33 Middle 044180 FTED-001 FTO000 FTEDetall PSRD  01/08/20112/31/250 0.511278 0.511278 0.348762 [ R M -
41 Middle 044130 FTED-001 FTOO00 FTEDetail PSRD  07/01/20112/13/201 0.461538 0.247856 0147343 0213682 003bruw s s -
49 Middle 044180 FTED-001 FT0000 FTEDetall PSNR  10/08/20105/08/201 0.729323 0.729323 0.654865 of oomMssosesss B L -
62 Middle 044180 FTED-001 FT0000 FTEDetall PSRD  02/07/20112/31/250 0.407692 0.407632 0.245638 o 0.162054 04415C
70 Middle 044180 FTED-001 FT0000 FTEDetallPSRD  10/01/20112/31/250 0.827068 0.579314 0279861  0.247754)  0.299453 04418C I -
268
= T
270 Standard Colors
m [ 1} EEEER
m NoFill
2713 @ More Colors.
74
_EMIS _
U ..
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Remove Filters, View Highlighted Cells, and Save

ma % e e

B vove  mser paceLavour  romn |'.JL»>“ W
I
T . ) Connections

o

|

From the Data tab click on “Filter”

“ to remove all filters from the report

Focusing on differences in
original FTEs, adjusted FTEs,
and special education
adjusted FTEs can aid in
troubleshooting FTE report
data. Since many FTE Detail
reports are quite large,
highlighting can make the
effected FTEs more obvious.

perform simple formulas?

‘ Q I
F G H K p Q R - U W
1 Last Name First Nam«Middle N:LEA IRN  LEVEL 2 RE RESULT CCRESULT CC FTE FUND ENRL STAFENRL END ORIG FTE ADISTD F?ADJSYDS EGAL DIS STONT PC SENT R
2 Last First Middle 011506 FTED-00L FTO000  FTE Detail STEM 07/01/201 12/31/250 1 1 1 044180 90 PS
3 Last 0 0.491228 044180 100 -
. Notice that the highlighted cells are : Lowss . I
. u=| showing the amount of Original FTE (yellow) T
Last o 1 044180 100 -
¢ »+| and Special Education weighted FTE (green) 0 1o w0
10 Last [ 1 044180 100 -
e that is not being funded L teroam WO
iaet—Tr —Josoms Baito A oo Aeoewiton  oTvmimAvse 1 i “ s |t
""" L 0 1 044180 100 -
Investlgate if the FTE is fundable and if there is .. cowcposmison: =
p4876 0 0.091278 044180 50 -
an appropriate corrective action. Refer to the FTE = o 0 034160
. 8195 0 0.045113 034180 50 -
. | Adjustment report for Result Codes EMIS
\ s 15
Alliance
Quick Check * Are you able to add columns and

* Are you able to filter and highlight
adjusted values that should be
investigated?

» Are you looking at the FTE Adjustment
report to identify the causes of the
adjustments?

EMIS
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Use VLOOKUP to add LEA Names
from OEDS to a Report

EMIS
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Adding LEA Names

* Most EMIS reports contain IRNs and no LEA names which can make
troubleshooting difficult

* This section will add LEA names to the FTE Detail report for a more
user friendly outcome

* We will begin by running a report of LEA IRNs and names from OEDS
and will perform a VLOOKUP to add the LEA names to the FTE Detail
report
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\1

Use OEDS Data to Create a Source File

https://oeds.ode.state.oh.us/SearchOrg
LEA data can be pulled into Excel using the OEDS Data link

HOME ABOUT ODE STATE AGENCIES ONUINE SERVICES  (Ohijo, gov
— ‘ Department g
Oth | of Education [CHTTET Session Timeout 0029 47

CREATE ORGANIZATION

Search Organizations

Q Search Organizations
SEARCH BY ADDRESS & Search Tip

Searches are Not Case Sensitive, Searches retum
Q Search Organizations Search by Organization Type 30 0rgaNEALONS that MALCN your Search term in
Please select | any part of the OIJANZatON's name, ¢ity of Lounty
= of its address, or ts IRN. For example, searching
for “colu™ will show all schools and districts with
“Columbus” in their name, all schools and districts

SEARCH in Columbiana county, i

EMIS

4.

Alliance

|

|

2 Select the organization types and click Generate Report to
DISTRICT [-) view OEDS data.

Select LEA Types

s Select District LEA Types to Include

Search Organization —+ Public Extract Data

OEDS Reports

PUBLIC EXTRACT DATA

A Instructions

Select Organization Types By Categories

Al District types
© What Will Be Included In The Report
Public Distnct Nonpublic Distnct
al School District

REPORT INCLUDES

SCHOOL

Selected District LEA SELECTED LIST OF ORGANIZATION TYPES I
types will appear here )

INFORMATION TECHNOLOGY CENTER

HOOL DISTRICT

EMIS

ﬁ%‘ 20

Alliance

EMIS Alliance

10



|
|

|

Select School LEA Types

Select School LEA Types to Include

Select the organization types and click Generate Report to
view OEDS data.

© What Will Be Included In The Report

REPORT INCLUDES

DISTRICT o

All School types

SELECTED LIST OF ORGANIZATION TYPES

Selected School LEA
types will appear here

,
=

INFORMATION TECHNOLOGY CENTER

POLITICAL DISTRICT

P O

L MEDIA

Eyls -
.
Alliance

\1
\

Select More LEA Types and Generate Report

PUBLIC EXTRACT DATA
T —
DISTRICT et I ey . Dicala
scHoo Educational Service Center

INFORMATION TECHNOLOGY CENTER

SELECTED LIST

POLITICAL DISTRICT REPORT INCLUDE S

State Supported Organization
State Supported School
Developmental Disabilities
Organization

MEDIA | SELECTED LIST OF ORGANIZATION TYPES |

UNIVERSITY/COLLEGE

SERVICE CENTER

CHILDCARE/PRESCHOOL

STATE ORGANIZATION

Scholarship Provider
Unclassified OEC Service Provider

STATE SUPPORTED ORGANIZATION

00000000090

OTHER ORGANIZATION

Click on “Generate Report” __— 1

.

Alliance

CHILD NUTRITION ORGANIZATION
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. Prepare the Source File

' Delete the top row

Al - Jfr || Generat e T P "
I BI=OD-A-H-93
A B G D E - o - i J K

1 [Generated on 7/25/2019 10:57:13 AM =

2 IRN ORGANIZ/SCHOOLT GRADESP ORG/ . s - AILO

3 132746 Summit A ElementaiK-6 com{ © P Select the top row, right | .

4 /132746  Summit A Communi K-6 Comi ¥D |[FasteOptions click, and select “delete” pnt (1

5 132761 Summit A ElementaiK-12 com [ = “@ Greene  hItps://su eric.martF 1693 Pawr (4

6 (132761  Summit A Communi K-12 comi o ;p ey Greene  https://su eric.martk 1694 Pawr (§

7 1132779  Summit A Middle Sc 6-8 Comt Summit https://sucrystal.yir 464 S Haw (3

8 (132779  Summit A Communi 6-8 Comi jnsert Ssummit  https://su crystal.yir 464 S Haw (3

9 1132795  Cliff Park |High Scho 9-12 Comi Delete Clark http://ww N/A 821 N Limu (9
_EMIS _
“se .

Alliance

\. Sort Both Files

|
| |lmao-c wxew- 1. Select all data on the report by
|| e e o Fomand| clicking on the triangle between
e | e B | row 1 and column A or use CTRL A
Access Web Tet Sources Connections  All~
Get External Data Connections Sort & Filter Data Tools I
Wle o | wossner 2. From the Data tab, choose Sort
A B (= D E F G H 1 J K L M N o P
1 I‘N ORGANIZ/ SCHOOL T GRADE SP. ORGANIZ/ ORGANIZ/STATUS  DESIGNAT WEB URL ORG EMAIORG MAIL ORG PHOI ORG FAX SUPERINT SUPERINT SUPERINT TREA
NaAfss210  [stiude 8 publi Open http://ww eichhold.I 5340 Bridg (513) 598- (513) 598- N/A N/A N/A N/A
3 (055228 stL K-8 Open rhsc@crls 1030 L acce [R121AI1.. L6121 033 4/
4 |055103  stiames Ely 8 1 Ope Sort -
| | : ::::: ces : IR g E 21 Add Level “ X Delete Level JI ) Copy Level [ Options... J 7] My data has headers
| | 7 |044826 steubenviN/A  N/A  PublicDisDistrit Opef | Column Sort On Order
’ 8 060889  Trinity Ev K-8 i Opet slues [v] |atoz [« | /A
9 |040279  Wellsville High Scho 8-12 PublicSchSchoel Qp
ne ;"""I"" h s"’ 4. Repeat this sort on the LEA IRN
.In rt prom r .
o the Sort prompt, sort column on the FTE Detail Report
upuzzs| by IRN and click OK. If a sort T
049353 -~ |ED
,‘ warning appears, click OK ‘
\ 18 10 { ‘ E.ﬂﬂls »
\ .
Alliance
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. Adding LEA Names to FTE Detail Repo

I BHE S Bxe e:- ]
\ FILE HOME  INSERT  PAGELAYOUT  FORMULAS = DATA = REVIEW  VIEW
[m M 1‘ L:, = H" 2 Connections 5 A \Y =5 5 B8 4
Lids LS = L L &4 =l Pron AlZ) L = =H
From From From FromOther  Existing  Refresh z| Somt  Filter _ Tetto Flash Remove  Datd
Access Web Text Sources~ Connections  All~ 2 .
Get Exernal Data Connections s 1. Select the column to the right of
/ - X u -« 5-% 1{the LEA IRN column, right click
=o-A-H-93
- i «“ ”
and select “Insert”. Label the
F G K L M
1 |Las!NameF|rstNam- gidle N:LEAIRN Lt X Cut ATCCFTEFY naw column "LEA Name”
2 liact Eirct diddla 011806 {F oy Copy Detail STEM
H F - z Detail STEM  08/15/20103406/201 0.491228 0.491228
[y Paste Options:
2. Place cursor in the F o =, o Detail COMM _08#277201 05/31/201 1 1
. . Sa 1= LG
first open cell in the new | 2 2 LW petail 08/13/201 12/31/250 1 1
ste Special... Pre 07/01/201 12/31/250 1 1
column, then select the Detail OPDD  05/28/20112/31/250 0.048088 0.048088
. . I Detail COMM  07/01/201 12/31/250 1 1
function icon §E - Detail J)SN  08/20/201 05/30/201 1 1
S e aare—womm— B CedCentents  peailcomm  07/01/201 12/31/250 1 1
11 |Last First Middle 054239 |F [ Format Cells... Detail JPSN 09/19/201 05/31/201 0.92 0.92
12 |Last First Middle 046128 [F  Cojumnwidth.. Detail OPDD  08/15/20112/31/250 1 1
\ 13 |Last First Middle 052803 |F Hide Detail JPSN 07/01/201 06/30/201 1 1
\ 14 [Last First Middle 044180 |F ;nmde Detail RGJV 07/01/201 12/31/250 1 1 _ EMIS
ar Adiadadl FET.! i E 4 . il n, Y.L 4 CYWLYS 3 B e SR
Uﬂ%‘h
\ RThS 25
Alliance
1
|
\
. Begin the VLOOKUP
~ bEg
‘| If VLOOKUP does not appear
F G H 1 J K L M N| e . .
‘ 1 |Last NameFirst NamiMiddle N¢LEAIRN  LEA Name e A n the IISt Of funCtlonsl SearCh
| = = B e «“, ”
2|t Fist  Middle 011506 |= | - for VLOOKUP and select “Go
3 |Last First Middle 011506 aEuior s fundion:
4 |Last First Middle 000236 Type a brief dgseffBtion of what you want to do and then
5 Last First Middle 000577 S
6 |Last First Middle 009957 Or select a category: Most Recently Used B
/ 7 Last First Middle 045054 Select a function: i 0.0480:
8 |Last First Middle 000241 | j
9 Last First  Middle 052878 CONCATE K|
10 |Last First Middle 009957 SuM =
11 |Last First  Middle 054239 ML Select VLOOKUP from the
12 |Last First Middle 046128 PROPER
[ T — Y 1 H ” \;
13 |Last First Middle 052803 vicorurteokup vanetnie | - O€lect a Function” list
5 ; Looks for a value in the leftmos! .
14 |Last First Middle 044180 in the same row from a column and cllck ”OK"
15 Last First Middle 044180 sorted in an ascending order.
16 |Last First Middle 044180
17 |Last First Middle 044180
18 |Last First Middle 044180 Help on this function
19 |Last First Middle 044180 —-_— e
S —
20 |Last First Middle 044180 FTED-001 FTO000  FTE Detail PSRD 03/04/20105/23/201 0.323308 0.3233
21 last Eirct Middl 044180 ETED. i

EMIS

e

Alliance

EMIS Alliance
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- Build the VLOOKUP

‘I CIE ==
‘ HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
||
Get Exteral Data Connections 1. Be sure that your cursor isin
12 - fe =vioOKUP(12 H “ ”
Xk - the field next to “Lookup_value
F G H 1 J K L M N o P Q R s T
1 Last NameFirst NamiMiddle N& LEAIRN _ LEA Name LEVEL2RERESULT CCRESULT CCFTE FUND ENRL STAFENRL END ORIG FTE ADISTD F1ADISTD SFORIG vs ADJ
2ftast  Fist  Middlepl0l; Jrrg— = S S
3 Last . Middle _ 011506 snction Spments

236

2.Selectcell 12 |s
in the “LEA IRN” [

VLOOKUP

241
column a7 \
557 f
11 |Last First Middle 054239 | o

for a value in the leftmost column of a table, and then returns a value in the same row from a column you

|

L]

|

L

]
E
aaas

Table_array field

4. Place cursor in the

able must be sorted in an ascending order. 9
12 |Last First h . q
3 it it 3. See that 12 appears in |twowpaie Lsﬂ}::\::::.:zzif::.:ﬂ::;:;:ﬂ column of the table, and can be a d
14 Last First . q
st s | the Lookup_value field d
16 Last First ITOTE—sEToT T q
17 Last First Middle 044180 I s - [ cancer | |02

Help on this function ncel
3 |Last First Middle 044180 ml rn q . EmIS
5.
Alliance

Build the VLOOKUP, cont’d

* Toggle to your OEDS Data spreadsheet and place your cursor in cell A2
* While holding down the Shift and CTRL keys at the same time, press

right arrow then down arrow

This will populate the Table_array field

63041151175

B

C [*] E F G H I ]

Tomorrow Dropout R 6-12
Mahoning High Scho 4-12
Mahoning Communi 4-12
Mahoning Virtual Sci4-12
Mahoning Dropout R4-12
Goal Digit High Scho K-12
Goal Digit Communi K-12
Goal Digit Virtual Sci K-12
Goal Digit Dropout RK-12
Fairborn C High Scho 9-12
Fairborn CCommuni 9-12
Fairborn C Virtual Sci3-12
Fairborn CDropout R9-12
Life Skills High Scho 9-12
Life Skills Communi 9-12
Life Skills Dropout R9-12
Foxfire Hi Ungraded 4-12,UNG
Foxfire Hi Communi 4-12,UNG
Waest Cent High Scho 3-12
West Cent Communi 9-12
Waest Cen! Dropout R9-12
West CentBlended §9-12

Communi School
Communi S¢

K L
Open Morrow  http://the N/A

0 P

M
3700 Cour (419) 718~ N/A /Kayn jbyrne@t! (740) 341- Steg]

Communi Sc

Function Arguments

S

o e e (330) 533- 8lai

Communi Scll | VLOOKUP

Communi Sci
Communi Sc
Communi Sci
Communi Sci
Communi Sclli
Communi Sci)
Communi Sclii
Communi Sci}
Communi Scli
Communi Scii
Communi Sciil
Communi Sci
Communi Sci}
Communi Sci!

Lookup_value 12 S| = 011506"

Table_array | xisx|DatalSAS2:5X36320 = [000059","Ada Elementary School”, El

e (330) 533- Blai
e (330) 533- Blai
e (330) 533~ Blai
& (419) 775- Steg

Col_index_num
Range_lookup

.
Looks for a value in the leftmost column of 3 table, and then returns a value in the ssme row fro| col I ndex N um fle I d

speaty. By default, the table must be sorted in an ascending order.

——=——___| Place cursor into

Table_array is a table of text, numbers, or logical values, in which data is retrieved.
Table_array can be a reference to a range or a range name.

Heip on this function

Formula result =

|
[
|/pht (805} 258- Jeffi
|
|
)

Communi Schi

Communi School
Communi School
Communi School

n
Open Allen
Open Allen
Open Allen

http://welN/A
http://welN/A
http://wel N/A

522 W Not (419) 227- (419) 227- Mindy Sch mindy.
522 W Noi (419) 227- (419) 227- Mindy Sch mindy.sch (419) 222- Karl|
522 W Not (419) 227- (419) 227- Mindy Sck mindy.sch (419) 222- Karl

T
I|@ (937) 879~ Tam|
1(805) 258- Jeffi

1 (805) 258- Jeff

(740) 453~ Lew|
| Jha (740) 453- Lew|
'sch (419) 222- Karl|
.sch (419) 222- Karl|

Alliance

EMIS Alliance
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Build the VLOOKUP, cont’d

BAE S BT ®-

HOME  INSERT  PAGELAYOUT  FORMULAS = DATA R
[ [ [_7-1 r\: [ { % [2] Connections 7]
l@ (& L8 E L& K

From From From From Other Existing Refresh
Access Web Text Sources~ Connections  All~

Get External Data

Connection

F30 - Jx || school

To determine the Col_index_num
count the number of columns from
the left that contain the values we
want to bring back from the OEDS file.
In this case, column B is 2 columns
from the left

A B

1 |IRN |~ | ORGANIZATION NAME ¥ |SCHOOLTYPE

2 000059 Ada Elementary School Elementary School
3 /000067 Ada High School High School

4 1000083 Sandusky Middle School Middle School

5 000102 Meigs Primary School Elementary School
6 /000105 Meigs Intermediate School Elementary School
7 1000117 Adamsville Elementary School Elementary School
8

000118 Hamilton Intermediate School Middle School

D E
~ |GRADE SPAN | ¥ ORGANIZATION TYPE
K-6 Public School
7-12 Public School
7-8 Public School
K-2 Public School
3-5 Public School
K-6 Public School
4-6 Public School
_ EMIs
— ,%5
'I‘@_ 29
Alliance

' Build the VLOOKUP, cont’d

o ¥ T e

HOME INSERT PAGE LAYOUT FORMULAS ~ DATA ~ REVIEW  VIEW

Get Externsl Data onnections Sort & Filter

The complete VLOOKUP
function appears here

VLOOKUP X « fr [:VLDOKUPIIJ,IZ_D(MO_OEDS_DJM.:Iulmla!&MZ:SxSﬁm.l,FAls{)]

A 8 C (2] E F G H 1 J K
1 RPTDESTIBIdgIRN SEVERITY SSID Emis ID Last Namé First Nam«Middle N:LEAIRN LEA Name LEVEL 2 RER
011111

RV666862: 123456789 Last First Middle 011506 |FALSE) [FTED-001 FTO000  FTE Detall STEM 07/]

M N

ESJLFCCRESULTCCFYEFUND « 2. Note that the first match

1

011111 | £1/00746K. 122456708 1 ace Cicce Atiddla  avisos 120001 ction Arguments appears in the prompt
o1l | H B 2
aue | 1. Insert 2 in the Col_index_num [ woowr
o11111 | . % Lookup_value | [2 £
o11111 | and FALSE in the Ra nge Iookup fo: Table_armay | xisx|Datai$as2 $x86320 ':\,] Ada Elementary School Bl |
o11111 | — s ~gex 2 s
o1 i PH284246: 123456856 Last First Middle 052878 FTED-00: Range, Jookna] FALSE )
o1 i LF0022882 123456875 Last First Middle 009957 FTED-00: - -
o TZ800248€ 123456919 Last First  Middle 054233 FTED-00! poonion Feviopl SER Soet

Looks for 2 value in the leftmost column of 3 table, and then returns 2 valud = STumn you
o | TT4424467 123456937 Last First Middle 046128 FTED-00] | specty. By defautt, the table must be sorted In an ascending order.
oL | 112262602 123456973 Last First Middle 052803 FTED-00: find tha dosest siasch ¥ the SVt colusn Boftad I
011111 1 VV420086 123456981 Last First Middle 044180 FTED-00] - JRUE or omitted; find an exact match = FA
o1l | DZ8444841 123456982 Last First Middle 044180 FTED-00: 3. cllck O‘K
011111 | XF022024( 123456983 Last First Middle 043180 FTED-00] |

ormuls result = Dayton Regional STEM School
o111 | BPBS064%: 123457010 Last First Middle 044180 FTED-00: — I
o TFS42485( 123457022 Last  First  Middle 044180 FTED-00] | Hel ok D conent ]}
o i DT680828( 123457027 Last First Middle 044180 FTED-00}-

EMIS
i}% N
e
"llu
Alliance

EMIS Alliance
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1
IR M3 e - i G H J K L
FILE HOME  INSERT  PAq N e N:LEAIRN LEA Name LEVEL 2 RERESULT
1 B, N T See the fIrSt LEA Name appear’ e 011506 [Daymn Regional STEM Sch D-001 FT0000
& e 0.5 |then double click or drag down | o0 ED-001 FT0000
Access Web Tedt rees Con| e 000236 FTED-001 FT0000
Gt to populate cells below 577 FTED-001 FT0000
’; =VLOOKUP(12,[2_DEMO_OEDS_Data.xIsx]Datal$Aa$2:5X$6320,2,FALSE)
A B C v} E F G H I J K L M
1 RPTDESTIBIdgIAN S| Middle NeLEA IR Name LEVEL 2 RERESULT CC RESULT CC
2 [oszes 01111 1| Widen the LEA Name e 506 [Dayton Regional STEM School |FTED-001 FT0000  FTE Detail
3 040404 011111 | Tddle 011506 |Dayton Regional STEM School [FTED-001 FT0000  FTE Detail
4 040404 011111 | column as needed Middle 000236 |Ohio Connections Academy In|FTED-001 FT0000  FTE Detail
5 |040404 011111 | iddle 000577 |Emerson Academy FTED-001 FTOO00  FTE Detail
6 040404 011111 | BX668420< 123456829 Last First Middle 009957 |Klepinger Community School |FTED-001 FT0000  FTE Detail
7 040404 011111 | INH408420 12345 = il
oo o s 12345 Before sending this report to others, change '
9 |040404 011111 | PH284246. 12345 il
iojosocos o1 vz 1235t the formulas in column J to values. Right click !
11fods0s 011111 1 T2800248€ 12345 it
plowos o 1 mwessizest column J and choose “Copy”, then right click 1
and paste values o
R 31
\ Alliance

Quick Check

reports.

FTE Detail report can make
the report easier to 5
troubleshoot. Consider doing report:

the VLOOKUP on other * What other EMIS reports could be
made more user friendly by populating
LEA names into the report?

columns in the FTE Detail
report or on other EMIS

e Are you able to generate an LEA report

Using data from OEDs to from OEDS?

populate LEA names into an * Are you able to perform a VLOOKUP to
add LEA names to the FTE Detail

s T 32
Alliance

EMIS

EMIS Alliance
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Create a MACRO to Format a
Spreadsheet

|
|

Create a Macro

* A macro can be created to complete spreadsheet set ups
with one click
* Freeze Top Row
* Wrap Text in the Header Row
* Justify column width
* Apply Filters
* Create it once and use it over and over

* Start by opening any FTE Report from the Data Collector

EMIS Alliance

17



.~ Begin Creating a Macro

. From the View tab, select the down arrow under Macros and
select “Record Macro”

DEMO_1_MACRO_FTE_Detail_Report.dsx - Bxcel ——————————————————————— 7 ®m - 8 X
( - =] _ip‘:[ ™ = Select the down arrow
Zoom to New Arrange Freeze __U.I :d Switch Macros
Selection Window All  Panes~ nhiGe Windows ~ M
X Window B ViewMacros /I This begins the recording
[ ®7 Record Macro /] A
;' UseR Record Macro
1 J K L M N o] P Q R Record a macro V w -
le NLEAIRN LEVEL 2 RRESULT CRESULT C FTE FUNL ENRL STZENRL ENIORIG FTE ADJSTD FADJS Each of th __ NTREASENTRI
le NO12664 FTED-001FTO000 FTE Detai ATSM 07/01/2012/31/25 1 1 ‘ o
le NO12664 FTED-001FTO000 FTE Detai ATSM 09/26/2012/31/25 0.85714 0.85714 0.8% youc t ac
le N133333 FTED-001FT0000 FTE DetalCOMM  08/21/2012/31/25 1 1 040404 100 -
le N133333 FTED-001FT0000 FTE DetaiCOMM  03/02/2012/31/25 0.05525 0.05525 040404 100 -
lle NOOO444 FTED-001FTO000 FTE DetaiCOMM  07/01/2012/31/25 0.42778 0.42778 040404 100 - - —
H‘O‘,&‘. ﬂ" 35
Alliance
‘\
\
|
. Set up the prompt Enter a Macro name or leave as the
[ast Nam First Nan Middle N000444 FTED-001 FFW default value
Last rR v O] 2 tai
[ast ecor acro / tai
Last| | Macro name: / tai R
Eaet iRl /| | Enter a unique Shortcut key value
Last| | shortcut key: Tip- enter a value that you don’t typicall
key:
t"“: Ctrl |t | — use as a Ctrl command (don’t use values
as .
[asti e maay such as Ctrl A, Ctrl C, Ctrl V, etc.)
Personal Macro Workbook El
Last
Last Description:
Last Select “Personal Macro Workbook”
st from the “Store macro in” dropdown
Last .
menu then click OK
Last oK Cancel
LL::: ;vlam First Narr Middle N040404 FTED-001FTO000 FTE Deta i
" i ~
b o S Y
AI;:;nce

EMIS Alliance



|
' *Macroisn

- Recording the Macro

ow recording

* Ready status and a small square icon show at bottom left

/ 1040404 042222 | TW26248 Emis ID  Last Nam First Naw Middle N040404  FTED-001 FT0000

| B2|040404 042222 | XG70213:EmisID Last Nam First Nam Middle N040404 FTED-001 FT0000
53 040404 011606 | DD84801:Emis ID Last Nam First Nam Middle N011606 FTED-001 FT0000
34 040404 011606 | LS693436 Emis ID Last Nam First Nam Middle N011606 FTED-001 FT0000
B5 040404 011606 | FL311036 Emis ID Last Nam First Nam Middle N011606 FTED-001 FT0000
f‘; Hovering over the icon will generate the message-
=] 0 . . 0
b “A macro is currently recording. Click to stop recording.”
FTED-001) FTE Detail043968-201 ®

Normal Page Break Page Custom
Preview Layout Views
Workbook Views

Al e

A B C

| Gridlines |v| Headings
Show Zoom

Jfr | RPTDESTIRN

D E F G H

Zoom 100% Zoomto
Selection Window Al Panes~ [JUnhide

Mew Armange Freeze

Window

J K L M N o

s
| Recording the Macro, cont’d
Start by selecting the top row
@ d o 3 = B L i ———— a2
| W R seminse Q [3 [ B B B ==

Switch  Macros
Windows ~
Macros

P Q R

Emis ID_ Last Nam First Nan Middle NLEA IRN

LEVEL 2 RRESULT C RESULT C FTE FUNLENRL STA ENRL ENI ORIG FTE ADJSTD FADJSTD §

040404 133333 |

000444 |
040404 149888 |
040404 149888 |

W N O U bW

l.%PT DEST Bldg IRN SEVERITY SSID
2 040meg L} RI3583902 Emis ID

KA43983{Emis ID
GM78917 Emis ID

Nam First Nary Midd

on the “1” to select

Last Nam First Nam Middle N012664 FTED-001FT0000 FTE DetalATSM  07/01/20 12/31/25
1 TM58425 Emis ID Last Nam First Nan Middle N012664 FTED-001FT0000 FTE DetalATSM  09/26/20 12/31/25

Click

alCOMM  08/21/20 12/31/25

FTED-001 FT0000
COMM  03/02/20 12/31/25

the firSt row COMM  07/01/20 12/31/25

Last Nam First Nanr Middle N051555 FTED-001FT0000 FTE DetaiCTVC 08/17/20 11/01/20
Last Nam First Nanm Middle N051555 FTED-001FT0000 FTE DetaiCTVC 08/22/20 10/15/20

1 1 1
0.85714 0.85714 0.85714
1 1

0.05525 0.05525
0.42778 0.42778
0.00246 0.00246
0.00191 0.00191

: EMIS =
“.

Alliance

EMIS Alliance
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Recording the Macro, cont’d

)

From the View tab, select “Freeze Panes” and “Freeze Top Row’

@Eo5 o

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW

FlE g o s Q. [3 B =2 B EE™ ©

3 = ™ Hide nous Scrolling =
Normal Page Break Page Custom [/ Gridlines (v Headings Zoom 100% Zoom to New Arrange| Freeze . ) < Switch Macros
Preview Layout Views Selection Window Al (Paness)Unhide  EfReset Window Position | Windows » -
Waorkbook Views Show Zoom . Freeze Panes Macros

E-

Keep rows and columns visible while the rest of

Al - Jx | RPTDESTIRN " the worksheet scrolls (based on current selection).
Freeze Top Row )
=] Keep the top row visible while scrolling through
A B C D E F G H I J the rest of the worksheet. Q R
1 LRPT DEST Bldg IRN SEVERITY SSID EmisID Last Nam First Nan'Middle NLEA IRN LEVEL2RRES —— freeze First Column {ADISTD FADISTD §
2 (040404 012664 | RI358902 Emis ID_ Last Nam First Nan Middle N012664  FTED-001FTC = f;f;‘;,;:;":j'me":r'k‘sh::: serolling 1 1
3 /040404 012664 | TM58425 Emis ID  Last Nam First Nam Middle N012664 FTED-001 FTOuwu ric uetararow —uzrzurev xeraaycr wosrzs 0.85714 0.85714
4 |os0404 133333 1 X1702135 Emis ID  Last Nam First Nam Middle N133333  FTED-001FT0000 FTE DetaiCOMM  08/21/20 12/31/25 1 1
5 040404 133333 1 TS809912Emis ID  Last Nam First Nan Middle N133333  FTED-001FT0000 FTE Detal COMM  03/02/20 12/31/25 0.05525 0.05525
6 |040404 000244 | MN68131Emis ID Last Nam First Nan Middle N000444  FTED-001FT0000 FTE DetaiCOMM  07/01/20 12/31/25 0.42778 0.42778
7 040404 149888 1 KA43989{Emis ID _ Last Nam First Nan Middle N051555  FTED-001FT0000 _FTE DetaiCTVC _ 08/17/20 11/01/20 0.00246 _0.00246
_EMIS
. .,
Alliance

 Recording the Macro, cont’d

From the Home Tab, select “Wrap Text”

B e =
FILE INSERT ~ PAGELAYOUT ~ FORMULAS  DATA  REVIEW  VIEW
= - :
= ?‘(‘" Calibri ‘u -|A S == 2 Text i 5 % | Normal
Pacte B COPY » Conditional Farmat
aste - ol #e . = 5% " 5 «o 00 Conditional Farmat as
o° oromatPaine B T Y - 2~ & | = = [ Merge & Center $-%0 WA Formatting = Table~
Clipboard ~ Font 1) Alignment i Number 1
a1 | i fx | ReTODESTIRN
A B C D E F G H I J K L M N o P Q
LEVEL 2 FTE
RPT REC RESULT FUND  ENRL ENRL
DEST SEVERIT Last First Middle TYPE RESULT CODE PTTRN START END ORIG ADJSTD |
1 [IRN Bldg IRN ¥ CODE  SSID EmisID Name Name Name LEAIRN CODE CODE DESCR CODE DATE DATE FTE FTE 1
2 040404 012664 | RI358902 Emis ID  Last Nam First Nan Middle N012664 FTED-001FT0000 FTE DetalATSM  07/01/20 12/31/25 1 1
3 /040404 012664 | TMS58425 Emis ID  Last Nam First Nam Middle N012664 FTED-001FTO000 FTE Detal ATSM  09/26/20 12/31/25 0.85714 0.85714
4 (040404 133333 | X1702135 Emis D Last Nam First Nam Middle N133333  FTED-001FT0000 FTE DetaCOMM  08/21/20 12/31/25 1 1
5 040404 133333 | TS809912€Emis ID _Last Nam First Nan Middle N133333 _ FTED-001FT0000 FTE Detal COMM _ 03/02/20 12/31/25 0.05525 0.05525

EMIS

40
-
Alliance

EMIS Alliance
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. Recording the Macro, cont’d

EMIS
-
."1&‘ 42

Alliance

‘ m HOME l INSERT ~ PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW
[
H H C- = o
 Click on the triangle ™ b Cut Calibr u AN ==E o EBwepie Ted
- EB Copy ~ N -
between Column A and Paste o ity B I U EHe DA S== &5 EMegeticenter - § -
Row 1 to select the Clipboard C Font 5 Alignment 5
/'l| entire spreadsheet AL > Jie | RPTDESTIRN
M A B C D E = G H 1 J K
Place cursor between any b = ’
two column headers and || et SEVERIT last  First  Middle TYPE  RESULT
double click Ems s = L1 [IRN BldgIRN YCODE SSID  EmisID Name Name Name LEAIRN CODE CODE [
ouble clic //’ 2 040404 012664 | RI358902 Emis ID Last Nam First Nam Middle N012664  FTED-001FT0000 §
S, 3 /040404 012664 | TM58425 Emis ID  Last Nam First Nam Middle N012664 FTED-001FT0000
SWC 4 040404 133333 | X1702135 Emis ID  Last Nam First Namr Middle N133333  FTED-001FT0000 f
5 040404 133333 | TS809912Emis ID Last Nam First Nan Middle N133333  FTED-001FT0000
_ EMIS
— ,%5
'I‘@_ 41
Alliance
-
1
\
|
‘t
H V4
|
. Recording the Macro, cont’d
|
“ H ” “ur: ”
From the Home tab, select “Sort & Filter” and then “Filter
| 5 T® - & %
INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Hrosch, Tammy =
i, ST Calibri a A ) = ¥ EWepiet T - X R E:‘“’““'" : é\_v i
B Copy - s ) Fil+
basie \'rm':m-.uamm Bryu- M- S-A- EE BMegeacene - Note bsart: ulvte Fommat | o chene " ik
upb Font €anl B] SetAteZ
a1 - fr | reTOESTIAN R Szl A
LY e}
G T [ S R Ve S AR ] YD | ey
STATE
LEVEL2 EQuiv
RPT REC SENT SENT GRADE DISAB SPECED ECON CAL cr
DEST SEVERIT Last First Middle TYPE REsuL PN REASON REASON LEVEL CNDTN CAT DISADV LEP FTEINCL CALDIST BLDG  GF
1 |IrRN BIdgIRN YCODE SSID  EmisID Name Name Name LEAIRN CODE  CODE 2 2PCT CODE CODE CODE FLAG CODE CODE RN IRN LE
2 040404 012664 | RI358902 Emis 1D Last Nam First Nan Middle N012664  FTED-001 FT0004 < L 12 6 N N FULL 999999 999999 **
3 040404 012664 | TMS58425 Emis 1D Last Nam First Nan Middle NO12664  FTED-001 FT L 12 6 N N FULL 999939 999999 *°

EMIS Alliance
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Stop the Recording

Click on the small square icon at the bottom left to stop the

recording

Z8|0a0aua U1aaag
29 |040404 011777
30 |040404 042222
31|040404 042222
32040404 042222
33 |040404 011606
34040404 011606
35040404 011606
36

JHZZ3I564 EMISID [@stName FIirst Name Miadle Name U51555 FIED-
MM3506602 Emis ID Last Name First Name Middle Name 040404 FTED-
KS2624834 EmisID Last Name First Name Middle Name 051555 FTED-
TW2624834 EmisID Last Name First Name Middle Name 040404 FTED-

The appearance of the icon will change and a hover
message will appear. “No macros are currently recording.
Click to begin recording a new macro.”

fTED-
[TED-
FTED-
[TED-

(FTED-001) FTE Detail043968-201

EMIS

Alliance

Make the Macro a Quick Link

Select the Quick Link dropdown
arrow, then “More Commands” [“=

Y o ¥
H - i} Z| s |
FILE HOME INSERT Customize Quick Access Toolbar ATA REVIE|
o ] New
36 cut Calibri = -
> ER Copy - 1 Open
aste = ==
T Frormatpanter | B T| v Save = | ==
Clipboard 5 ~  Email Aligni
Quick Print
AL -
Print Preview and Print
Spelling
= H L + Unde H
+ Redo
Sort Ascending ENRL
First Middle Sort Descending START
1 |Namel~|Name[~JLEAIRI=]  Touch/Mouse Mode ~lpate [~]
> |First Nam Middle N 012664 07/01/20
More Commands
3 |First Nam Middle N 012664 - 09/26/20
4 |First Nam Middle N133333 Show Below the Ribbon 1 08/21/20
5 |First Nam Middle N133332  FTED-001FT0000 FTE Detal COMM  03/02/20
& |First Nam Middle N0O00444 FTED-001FT0000 FTE Detal COMM _ 07/01/20

Cuntomize Quick Access Tootbar:
For il documents (default) -l

H s
 undo
O Redo

In the “Choose commands

from” dropdown, select “Macros”

001 Developer Tab ]
-001] Add-lnsTab -
oo1 N B
-001 SmartAnt Tools | Design Tab &
-001] A 1
001l oy
001l 1
oo o
001 ool
001} 1
woill Cumemizatiens: | Raset > N
oot imgo/ispon = -
oo1f| - -
oonf| Lo Camcel -
ool —_ = = o
EMIS
=\
Uﬂ%' 44
5
Alliance

EMIS Alliance
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- Make the Macro a Quick Link

| Highlight your macro from

the list and click “Add”

The macro will move to the list on the right.
While it is highlighted, select “Modify” and

fxcel Options Ut
& o choose an icon that you like. Click Ok and Ok.
= S e — Py — e - .
o - © Redo
- e
- <Separators ﬁ;‘; e Rid < ‘”“\
—I O Redo Q\xk-‘“ﬁ\?odul L2l LS8 Macrol
=== o [l ————
TS [ om :
1 |
T |
| -
|
‘
‘
|
|
Show Quick Access Toolbar below the Cusomizstions: |SRmstes Show Quick Access Toolbar below the Comomiztons |t
Fabben P Ribbon Imgon/Export ~
| 31_ Cancel. oK Cancel
EMIS
ey
5N
Alliance

\'- Quick Link

' New Quick Link now appears

5o o @ 3[e)
HOME INSERT PAGE LAYOUT

2 040404 012664 |
3 /040404 012664 |

A nanana 132293

FORMULAS ~ DATA  REVIEW
o X . = -
o - Calibri Ju e E=E e B
P E® Copy -~ .
aste ¥ = === = 3=
= ¥ FormatPainter  © 1 U » - A === &5 Bwm
Clipboard ] Font 1 . . . .
To remove the Quick Link, right click
E - 5 E on the icon and select “Remove from
FEC e e e | QUiCK Access Toolbar”
Fa_ste :Fm'::“pmw B I | Custs e Ribbon... Merge & Center = $ - % 8
Clipboard Collapse the Ribbon Number
Al ~ Jfe | reTDESTIRN
A B C D E F G H 1 K L

1 RPTDES'I.EIngRN SEVERITY SSID EmisID Last NamFirst Nan Middle NLEA IRN LEVEL 2 RRESULT CRESULTCFTEH
RI358902 Emis ID Last NamFirst Nan Middle N012664 FTED-001FT0000 FTE Detai ATS!
TMS58425 Emis ID  Last Nam First Nam Middle N012664 FTED-001FT0000 FTE Detai ATS!

1709198 Eonic IN 1 ack Miam Ciect Mar 8iddla A1199323  ETEN ANY ETAMAN  CTE Natal AN EMIS

Alliance

EMIS Alliance
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Save the Macro

* You can choose to save or not save your spreadsheet

* A second prompt will ask if you want to save the changes
made to your Personal Macro Workbook

Detail COMM 07/01/2018

Detail
Detail Microsoft Excel

12/31/2500 0.427778 0.427778

|

Detail
Detai !
Detal
Detai
Detal

Select Save so that the macro will be
available to use on future spreadsheets

B435
1

Detai

Detai

Detail NFRG 09/07/2018 12/31/2500 0.964286 0.964286

EMIS

SN

Alliance

Delete a Macro

Once a Macro is created a few extra steps are needed to
delete it if needed

@A 3> @ -

GELAYOUT ~ FORMULAS  DATA  REVIEW

HOME INSERT

PA

| From a new or existing spreadsheet
" select “Unhide” from the View tab

Workbook Views

Al

A B

2 040404 012664 |
3 040404 012664 |
4 040404 133333 |
5 040404 133333 |
6 040404 000444 |

C

Show Zoom

Jx | RPTDESTIRN

1 |RPT DEST_IBIdg IRN SEVERITY SSl

RI3
T™:

In the Unhide prompt with
PERSONAL.XLSB selected, click OK

58425 Emis ID  Last Nam First Nam Middle N012664

X1702135 Emis ID  Last Nam First Nam Middle N133333
TS809912EmisID Last Nam First Nam Middle N133333
MNG68131Emis ID Last Nam First Nan Middle N 000444

FTED-001 FT0000
FTED-001 FT0000
FTED-001 FT0000
FTED-001 FT0000

DEMO_1_MACRO_FTE_Detail_ Report - Copy.xlsx

>
Unhide (L9 fomn)
Unhide workbook:
PesonaLss., ... M

FTE Detal ATS

FTE Detai ATSI

FTE Detal COMM  08/21/20 12/31/25 1 1
FTE DetaiCOMM  03/02/20 12/31/25 0.05525 0.05525
FTE DetalCOMM 07/01/20 12/31/25 0.42778 0.42778

EMIS
e
S

Alliance

EMIS Alliance
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Delete a Macro, cont’d
. A blank spreadsheet named PERSONAL.XLSB will open

Macro (L0

Macro name:

Macro2
Macro3

Step into

select “delete”

Select “Macros” from the View tab, then in the
Macro prompt select the macro to be deleted

QOptions...

: | All Open Workbooks [+]

n

|

When finished, close the Macro prompt and select —
“Hide” and the PERSONAL.XLSB will close

EMIS

WS T 49
Alliance

Quick Check

Macros are a quick way to
turn a multi-step process in
Excel into one click. Creating
a quick link macro does not
embed the macro into the
spreadsheet. This macro is for
use on the machine where it
is created.

* Are you able to record and save your
macro?

 Can you think of other instances where
a macro can save time?

* Are you able to find and manage your
macros?

EMIS

e 50
Alliance

EMIS Alliance
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FTE Detail Report Subtotaling

EMIS

".‘.l",&. -Qb 51

Alliance

- FTE Detail Report Subtotaling

' Subtotal the FTE Detail Report

* Sort by SSID, then by Enroliment Start Date

FILE PAGE LAYOUT FORMULAS l |
o T ;| From the Data Tab choose Sort
e g e Tolumns Duplicates Validation = Analys
ort &« Fiter Dsta Tooks
o" 14
Sort by SSID, then select “Add Level”,
A 8 c D E F 6 H P2
o 14
/ then sort by “ENRL START DATE”, then
RPT DEST SEVERITY o" ”
1, I
e _ame e e mosn e SElect “OK
B[ a0s04 10010 AF9794373 5 same Middla Mama  A0TCETED Ll
| aos0s 1010101 AF9734373 | Sort / — 12/12/2q
3 40404 101010 C AF9794373 - ] - == I 12/12/2(
6| 40404 1010101 Agassaasa | | isasatera [P pee et | [ gopytever | =[] [otons 07/01/2¢
7| a0s0s 1010101 157050834 07/01/24
[B| 4odod 1010101 157050894 09/04/24
P 40404 1010101 157938181 || M 10/17/24
lo] aod0s 1010101 KI3857778 07/01/2(
l1| as0s04 1010101 19471503 07/01/24
k2| s0s0s 1010101 109471903 09/04/24
13 40404 101010 1 KL6339882 07/03/2(
k4| 40404 1010101 KL6339882 12/13/2(
Is| aod0¢ 1010101 KL8s33970 fif - 07/01/2( EMIS
k6| aos0s 1010101 KL8333970 09/04/24 T~
k7| a0s0¢ 1010101 KL9685822 ) ST AT T OTE BT T TEDUOT P TOOrFTED M 08/21/2( "%' 50
Aliia.nce

EMIS Alliance
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Sort Warning

This Sort Warning is generated because the ENRL START DATE column
contains some numbers that are formatted as text

Name FirstName Middle Name = 111111 FTED-001 R

ome l—————— ==acaril [f @ Sort Warning is generated,

Name rtWaming

Name: The following sort key may;ot sort as expected Ieave as defaUIted and SeIeCt ”OK”

because it contains some numbers formatted as text:
Name ENRL START DATE

o | What would you like to do?
Name

| | @ Sort anything that looks like a number, as a o

Name Wl & <ort numbers and numbers stextseparatery |
AHGE oK Cancel Help

Name

Name
Name
Name

‘Middle Name | 40404 FTED-00;

'First Name

_ EMIS

H"ng.ﬂi 53

Alliance

Apply Subtotals

‘ HOME  INSERT  PAGELAYOUT  FORMULAS Dv REVIEW  VIEW

- H
@ Butng  Refresh 3| St Filte Te
Comnections | A= . : Yerdwonced | 4

TR e “ From the Data Tab select Subtotal

A B C D E F G H 1 J K L M N o P Q R t |

< | In the Subtotal Prompt select
T . “At each change in:” SSID
(|t e G § 2 2. “Use function:” Sum
o o e e | "k 3. “Add subtotal to:” ORIG FTE and
& mmee s 0 ===  ADJSTD FTE and ADJSTD SPECED
e - F  CATFTE
ems

EMIS Alliance



. FTE Detail Report Subtotaled

Access Web Tet Sources Connections  All*

“ HOME INSERT PAGE LAYOUT FORMULAS DATA
B B : % (&) Connections 4| [TTR
¥ < s R 2 [z
From From From From Other Easting Refresh Sort

REVIEW  VIEW

> . pes
s B é Lo = Show Detail
= =5 d L 2 ~3 Hide Detail
Fiter Tedto Flash Remove Data  Consolidate Whatlf Group Ungroup Sublotal
VrAdanced  Colymns  Fill  Duplicates Vaidation ™ Analysis * . .

This student’s Original FTE, Adjusted FTE, and Special
Education FTE, have been subtotaled and L
appear chronological order fosto

RPT DEST PECED
1 IRN Bldg IRN CODE SSID EmisID LastName FirstName  Middle Name DESCR CODE  DATE DATE ORIG FTE FTE CATFTE LEGALD
2 | 40404] 101010 F AFS330185 EMISID LastName FirstName Middle Name 40404 FTED-001 FTE Detail NFRG 08/01/2017 12/31/2500 1 o 202
- 3 AFS330185 Total 1 [ 0
4| 4004 101010F AF9794373 EMISID LastName FirstName Middle Name 40404 FTED-001 FT0000 FTE Detail 07/01/2017 12/11/2019 0.376623 ] 40404
s| 4004 1010101 AF9734373 EMISID LastName FirstName Middle Name 111111 FTED-001 FT0000 FTEDetail PSET 17 12/31/2500] 0.612676 0.612676 0.612676 |asaass
6 40404 101010 C AF9734373 EMISID LastName FirstName Middle Name 40404 FTED-001 FTO000 FTE Detail PSRD /25000 0.623377 0.387324 0.387324 | 40404
-7 AF9794373 Total 1.612676 1 1
[ 8| 40404 1010101 AGI44498 EMISID LastName FirstName Middle Name 111111 FTED-001 FT0000 FTEDetail SPCO  07/01/2017 12/31/2500 1 1 1 444444
-] 9 AG3444498 Total 1 1 1
10 40404 1010101 157050894 EMISID LastName FirstName Middle Name 40404 FTED-001 FT0000 FTEDetall OPDD 07/01/2017 09/03/2017 0.020547 0.020547 333333
1 40404 101010 | IS7050894 EMISID LastName FirstName Middle Name 40404 FTED-001 FT0000 FTEDetail OPDD 09/04/2017 12/31/2500 0.979453 0.979453 333333
- 12 157050894 Total 1 1 0
13| 40404 1010101 IS7998181 EMISID LastName FirstName Middle Name 111111 FTED-001 FT0000 FTE Detail COMM 10/17/2017 12/31/2500 0.782609 0.782609 EFEERY
= 14 157998181 Total 0.782609 0.782609 0
15 40404 101010 1 KJ3857778 EMISID LastName  FirstName Middle Name 40404 FTED-001 FTO000 FTE Detail OPDD 07/01/2017 12/31/2500 1 1 333333
EMIS
L)
ThS 55
Alliance
m HOME  INSERT  PAGELAYOUT  FORMULAS = OATA  REVEW  VIEW
X Y by Bcomnections o 1) W T ~ B v L 9= AR Hazi
1 L@ s * Az ” = o 1 oZ= 1
From From From FromOther  Existing  Refresh 7] Sen  Filter Testto Flath Remove Data  Consolidate Group Ungroup Subtotal
Access Web Tet Sowceis Connections ANl® = Vadvanced Coumns il Dupbcates Valdation * A - . =
Get External Data Connecioni & Filter Data Toels Ot
a1 . fr | reroesTirn
I | btotals select “Subtotal”
o s s e o« + <« Toundo subtotals select “Subtota
and then “Remove All”
RPT DEST SEVERITY
1 [iRN BIGZIRN CODE  SSID (EmisID ATE ORIG FTE FTE
2 40404 101010 F AF5330185 EMISID Last 017 12/31/2500 1
= 3 Total 1}
4 40404 101010 F AFITH4373 EMISID  Last 07/01/2017 12/11/2017 0.376623
5| a4os04 1010101 AFI794373 EMISID Last 12/12/2017 12/31/2500 0.612676 0.61)
L} 40404 101010 C AFITHITI EMISID  Last 12/12/2017 12/31/2500 0.623377 0.38)
= Lol G Agd subtotalte: Lebsre)
8| 40804 1010101 AG344498 EMISID Last ENRL START DATE 0000 FTE Detail SPCO  07/01/2017 12/31/2500 1
-1 9 AG3444498 Total ENRL END DATE 1
10| 40404 1010101 IS7050834  EMISID Last |l o T ¥ FTED-001 FT0000 FTE Detall OPDD 07/01/2017 09/03/2017 0.020547 0.02|
11| 40404 101010 | IST050894 EMISID Last Ml | /) A0I5TD SPECED CAT FTE FTED-001 FT0000 FTE Detail OPDD 05/04/2017 12/31/2500 0.973453 0.97|
T 157050894 Total LEGAL DIST OF RES IRN A
13] 40804 1010101 1S7998181  EMISID Last FTED-001 FT0000 FTE Detail COMM 10/17/2017 12/31/2500 0.782609 0.78]
- 1 157998181 Total 0.782609 0.78(
15| 40408 1010101 KI3SSTI78  EMISID |Last FTED-001 FT0000 FTE Detall OPDD 07/01/2017 12/31/2500 1
-] 28] KI3857778 Total ] 1
17| 40404 1010001 KJ471903  EMISID  Last FTED-001 FT0000 FTE Detall RGIV  07/01/2017 09/03/2017 0.020547 0.02f
18| 40404 1010101 KIM71903 EMISID Last FTED-001 FT0000 FTE Detail RGV 09/04/2017 12/31/2500 0.973453 0.97] i
i
L /L
“Bhpe 56
Alliance
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Using Concatenation and

" Conditional Formatting to

j Verify Calendar Data and
Student Data

EMIS

\ Alliance

Data Comparison

* Compare the Calendar Display report to the Student Attributes
Effective Date Record (FD)

. * Look for students who have no matching calendar in the calendar
 collection

' j * Look for calendars being reported to EMIS that have no students

assigned to them

* Result will be cleaner data and correct calendar assignments on the
FTE Detail report

EMIS Alliance
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Calendar Display Report

Find the Calendar Display report that aligns with the current student

collection

* In this example we will use the Final Calendar Collection for FY19 and

compare it to the End of Year Student Collection for FY19

Calendar Collection - Final (EY19)

submissions: 00| Salect “View submission # Data”
submission s e @Nd find the Calendar Display
e o | Report and the Student Attributes
| Date Effective (FD) file

|End of Year Student Collection (FY19)

Data only available via Reports > Received\Files: in 501 days

Submissions: May 03, 2019 - July 17, 2019 (closed)

as submitted July 09, 2019 at 01:03:59 PM by
ompleted (July 09, 2019 at 01:03:39 PM)

Submission Number: 4 (
Prepare

Actions: Start Collec

EMIS

WIS 5

Alliance

Prepare the Calendar Display Report

* Run macro to prepare the report (original macro from FY19,
not new subtotaling macro) or prepare the report manually

* Filter Row Number column to include only Row 1

A B C D E F G
Calendar For: Dist-Bldg¢
1 Grade-AP ont * | Sund| ¥ | Monday ~ | Tuesday ~ | Wednesday |~ |Thursd

2 01 1isl 10

80 [oa0s04-001111-02-** Jo1 | The result will be an unduplicated list of
158 |040404-001111-03-** 1 o

236 loavsoaoo1111.00+« |n | €@lendars that are being reported to EMIS
314 |040404-001111-05-** 1 Jul-18

392 |040404-001111-KG-HA |01 Jul-18

470 |040404-001111-KG-HP 1 Jul-18

548 |040404-001111-KG-WC |01 Jul-18

625 |040404-008888-01-** 1 Jul-18

703 QMM-OOSSS&-OZ-" 01 Jul-18

EMIS

e 60

Alliance

EMIS Alliance
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‘
|
|
. Prepare the Student Attributes (FD) Report
| h iginal f 1
Run macro to prepare the report (original macro from FY19, not
new subtotaling macro) or prepare the report manuaIIy
BE S o 3 @ = X
G HOME  INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW Select the column to the I’Ight
ity B Calbr u <A x =2 o @wsie | of the Attendance Pattern column,
~ B Copy ~ ST I
PItE W Fomatpainer B T U~ E D-A- SE= EE EMegesCeme then right C|ICk and select “insert”
Clipboard Font Alignment Number
K1 - f! Disadvantagement Calibii -|11 ~| A" A7
BI=0-4A-
A B C D E F G H I J _K' L M N
State % Cut
Equiva Atten Ey Copy 2n!
EMIS Effective lent dance |Disac = —— S
[ Paste Options:
District Buildin StudentID Last First State Start Effective Grade Patter|anta| e 2d
1 |IRN |~ |gIRN v |Number |~ /Nan > Nan~ Student|~ Date |v/EndDa ~|leve~/n |¥|men| D 'lal
2 (040404 001111 1232456789 Last First VBOG62802 20180701 00000000 02 == [* 5
3 (040404 001111 1232456790 Last First XD4464240 20180701 20180814 01 == =
4 [040404 001111 1232456791 Last  First XD4464240 20180815 20190207 01 ** |1
\ 5 (040404 001111 1232456792 Last  First XDA4464240 20190208 00000000 01 == 1
\ 6 [040404 001111 1232456793 Last First HZ4820082 20180701 20180814 03  ** = EMIS
\ 7 [040404 001111 1232456794 Last  First HZ4820082 20180815 20190207 03 ** [1 wispe
. "
\ Alli'a‘nce

Concatenate Calendar Data

Name the new column (i.e. Calendar) and expand width of column

Function Wizard

1. Place cursor into cell
K2 then select the Insert

1 20

15 20190207 01
08 00000000 01

15 20190207 03

180814 01

180814 03

/

Sehect a functiopy

Calibri 1 A - Wrap Text General F a
A s | sewatmale | 2. If CONCATENATE does not appear
- in the list of functions, search
X
for CONCATENATE and select “Go”
H 1 K - < / <
z::«‘;a Atten Insert Function - [P
EMIS Effective lent  dance Searen for a fundction:
tudent 1y (e
Y o s e e e O el i .1'3? i e — | (o]
2 |oaom 001111 1232456789 Last  First VBO662802 20 = Or select a gategory: Most Recently Used -

CONCATENATE(text L te:

11040404 001111 1232456798 Last
\ 12 (040404 001111 1232456799 Last
‘A 13 (040404 001111 1232456800 Last
A 14 040404 001111 1232456801 Last
15 (040404 001111 1232456802 Last

First
First
First
First
First

T)2800886 20180701 O
XBS644622 20180701 2
XBS644622 20190516 2
XB8644622 20190517 04
TR4282260 20180701 0

x2...)

into one test string.

3. Select CONCATENATE from
the “Select a Function” list

and click “OK”

EMIS

- ‘,‘,ﬁt@ -

Alliance

EMIS Alliance
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Concatenate Function Arguments
Using the CONCATENATE Wizard, select the cells to include

COMCATE... ~ X o fr | =CONCATENATE(A2,"-",B2,"-",12)
* Place cursor in Text1 field b | e | * € | w 1| «
Equiva Atten
* then select cell A2 Erfective lent  dance g
ID Last First State Start  Effective Grade Patter q
L4 In Text 2 enter a dash ~|Nan~ |Nan| - [Student | - |Date |~ |EndDai~|leve~|n [~ ]calendar -
789 Last  First | VB0S62302 20180701 0D0DDO0DI02___1**  =CONCATENATE(A2,"-",B2,"-",12) E
1 H 790 Last Ficst DAASA2AN N1 BNTNL 201802814 01 % el
* Place cursor in Text3 field [ 7o xosemee T =
792 Last
* then select cell B2 sl [T
Textl A2 040404 -
794 Last — -
* In Text4 enter a dash iz [
796 Last Text3 B2 001111
* Place cursor in Text5 field |7 T o
. I
° h I " 799 Last = "040404-001111-02"
t eén se eCt ce Iz 800 Last Joins several text strings inte one text string,
201 Last TextS: textltext2,.. are 1 to 255 text strings to be jojpd inta a single text
802 Last string and can be text sti
16 040404 001111 1232456803 Last CIiCk the dOWn arrow
17 040404 001111 | 1232456804 Last Formula result = 040404-001111-02
18 040404 001111 1232456805 Last .
19 040404 001111 1232456306 Last Help on this function to see more flelds
0040404 001111 1232456807 last

EMIS

T 63

Alliance

Concatenate Function Arguments, cont’d

X v I

EMIS
District Buildin StudentID Last First State

=CONCATENATE(A2,"-",B2,"

12)

G H 1 J
State
Equiva Atten
Effective lent dance
Start Effective Grade Patter

1 IRN |~ |gIRN ¥ |Number |~ Nan ~ Nan v |Student| ~ Date |+ |EndDa|~ Leve~in |+

K L I

Presch
Disadv ool
antage Povert

Calendar ~ men|~ yley~

2 |040404 001111 1232456789 Last  First VB0662802 20180701 00000000 02 |

:ZNATE(AZ,”-",BZ,”-",IZ,”-",JZ} I‘ N

3 040404 001111 1232456790 Last  First XD4464;

XDasga| Function Arguments

B ) |

4 040404 001111 1232456791 Last  First
5 040404 001111 1232456792 Last First XD4464|| coNCATENATE
6 040404 001111 1232456793 Last  First HZA82 etz B2 001111° -
7 040404 001111 1232456794 Last  First  HZ482 Texta [ -
§ 040404 001111 1232456795 Last  First HZA82
S 040404 001111 1232456796 Last First TR8026 Tl 12 o
10 (040404 001111 1232456797 Last  First TT6282§) TextG |~ B
. Text? |12 e

* |In Text6 enter a dash

* then select cell J2
e Click “OK”

* Place cursor in Text7 field

lseveral text strings into one text string.

la result = 040404-001111-02-**

n this function

Text7: textl text2,...are 1to 255 text strings to be
string and can be text strings, numbers, or sing

4040400111102+

Qs

Preview of results

(20 loansns not112 1230458907 tact i Toosaalis

O
Alliance

EMIS Alliance
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Concatenated Calendar Data

Data from all four cells is joined together with dashes in the

at the data on the Calendar Display report

same format

EhREBe®muonaswn-

P
BEE L

18

040404 001111 1232456791 Last  First XD4464240 20180815 20190207 01 Sod

To delete duplicate values, select one or more columns that contain duplicates.

32 Select All

Columns
Effective End Date

State Equivalent Grade Level
acalattern

7] My data has headers

Disadvantagement
Preschool Poverty Level

K2 J& | =CONCATENATE(A2,"-",B2,"-",12,"-",12)
f A g c D E F G H 1 ] K L M
State .
Equiva Atten Double click or drag to
EMIS Effective lent dance .
District Buildin StudentID Last First State Start Effective Grade Patter Copy into Ce"s belOW
1 IRN |~ |gIRN ~ INumber |~ |Nan ~|Nan ~ |Studentl ~ |Date |~ |EndDa > leve~n |~ Calendar
2 040404 001111 1232456789 Last  First VB0662802 20180701 00000000 02 «*  |o40404-001111-02-** - N
3 |040404 001111 1232456790 Last  First XD4464240 20180701 20180814 01 == |040404-001111-01-** u N
4 (040404 001111 1232456791 Last  First XD4464240 20180815 20190207 01 =*  |040404-001111-01-** 1 N
5 |040404 001111 1232456792 Last First XDA4464240 20190208 00000000 01 == |040404-001111-01-** 1 N
6 |040404 001111 1232456793 Last  First HZ4820082 20180701 20180814 03 == |040404-001111-03 - N
7 |040404 001111 1232456794 Last  First HZ4820082 20180815 20190207 03 **  |040404-001111-03-** 1
8 |040404 001111 1232456795 Last  First HZ4820082 20190208 00000000 03 =+ |040404-001111-03-** 1 N
9 [040404 001111 1232456796 Last First TR8026626 20180701 00000000 04 == |040404-001111-04-** 1 N
10 |040404 001111 1232456797 Last  First TT6282640 20180701 00000000 02 **  |040404-001111-02-** 1 N
11040404 001111 1232456798 Last  First TJ2800886 20180701 00000000 05 ==  |040404-001111-05-** N
12 (040404 001111 1232456799 Last  First XBS644622 20180701 20190515 KG  HA G N
13 |040404 001111 1232456800 Last  First XB8644622 20190516 20190516 KG - = N
14 |040404 001111 1232456801 Last  First XBS8644622 20190517 00000000 KG  HA - N
15 (040404 001111 1232456802 Last  First TR4282260 20180701 00000000 04 e 1 N EMIS
16 |040404 001111 1232456803 Last First TR2088620 20180701 00000000 04 - = N B
an lnesne lnnazas s iase rie ‘Tonsancac nnscazas ansassnn sin - . U@‘ .
Alliance
Remove Duplicates
[ICEIEE B3 e-
HOME INSERT PAGE LAYOUT FORMULAS REVIEW VIEW
BBR D B RS-t & El
From From From From Other Bxisting Refresh 7| Sent Filter Tetto F Remove
Access Web Text Sources= Connections  All~ i Vo Advanced  Columns Duplicated
Get Extemal Dot Sort & Finte
Select alldata |. - fi | ouce
| . < I S S S S S S S N From the Data tab, select
.
el ket o “Remove Duplicates”
District Buildin StudentID Last First State Start Effective Grade Patter
IRN |~ gIRN ~|Number ~ Nan~ Nan - Student|~ Date ~ EndDa ~ Leve~ n  ~ Calendar I
040404 001111 1232456789 Last  First 'VBO0662802 20180701 00000000 02 fed 040404-001111-02-** I
040404 001111 1232456790 Last  First XD4464240 20180701 20180814 01  =* 04

=4 From the Remove Duplicates

« prompt, click “Unselect All” and
check the box for the column
containing the concatenated data,
then click “OK”

404-001111-04-**

001111-KG-HP
404-001111-KG-HA
04-001111-KG-** EMIS

ThS 66
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\
. Duplicates Removed

| 0OE % ¢ T S - ——— S ——
‘ HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

% & Connections. 4 [7Y 'T %

AlZ

71 Seet | Fille Test ta

duplicates removed, the report

now contains an unduplicated list of X t M| w| o | v g | ®
H Presch Disabil Student Homeless Limin
calendars assigned to students
TOVSTITCT BN STOOEmT 0 THST  FIrsT antage Povert Condit served by a ess panied  Profi
1 IRN = |gIRN~ Number |~ Nan > Nan = - Calendar =|men > |yLey=ion |~ 504 Plan |~ Statu = [Youth | = mey |
0 0OL111 1230456789 Last  First 040404-001111-02-** - N = N e N N
040404 001111 1232456790 Last  First | 040404-001111-01-** fe N 5 N - N L
040404 001111 1232456793 Last  First 040404-001111-03-** b N s N ¥, N L
00404 001111 1232456796 Last  First 040404-001111-04-** 1 N = N i N N
040404 001111 1232456796 Last  First (40404-001111-05-** * N " N O] N
40404 COLL11 1232456795 Last  First C40404-001111-KG-HA - N - N s N N
040404 001111 1232456800 Last  First D40404-001111-KG-** b N — N .
040404 001111 1232436504 Last  First sososoonirene o | 1. Click OK
040404 001111 1232456808 Last  First 040404-001111-02-DN - - -
2 e e mm 0 T7IT dup " e '/. remain.
s| 3. Scroll to the bottom of the report jusco =
1111-03-DN
020404 001111 1232857118 Last  First  ZHSBSE262 20190117 MM?.W we ononoa-muu-'m-wt | I |
040404 001111 1232457207 Last  First  XTOS23600 20180701 20180702 01 oN 040404-001111-01-DN

Alliance

PRt
N S
Alliance
Copy Data from Calendar Display Report
Toggle to the Calendar Display report
A B C (o] E F G H 1 J
Calendar For: Dist-Bldg- Row
1 Grade-AP * |Numb -T|Mont ~ Sund * |Monday - | Tuesday ~ |Wednesday |~ Thursday - |Friday - | Saturd
5298|040404-025555-03-** |01 Jul-18
53 025555-04-*= |01 Juk18
5454|040404-025555-05-"" (01 Jul-18
/ 5532|040404-025555-KG-HA (01 Jul-18
et Select cells in Column A (not including
gt the header row) then right click and
SRS oo -[11 | K x5 % 0 B select “copy”
6oT|odoa0a03 B T = - A-H WA
6155(040404-039156-08-wC |01 Jul-18
6232|040403-
6310|040404-
mw:; iy Paste Options:
6543/040404-131 n[j-
6621{040404-131 Paste Special...
6699(040404-13/ Insert Row
6776/040404-131 Delete Row
6854|040404-131
LEMIS
s
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~ Paste Data into Student Attributes (FD) Report

" Toggle to the Student Attributes (FD) report

A B c D E F 3 H 1 J K L M N o [ q
state
Equiva Atten Presch Disabil Student Homel
EMIS Effective lent  dance Disadv ool ity being Homel Unac
District Buildin StudentID Last First State Start Effective Grade Patter antage Povert Condit served bya ess panie|
1 /IRN [~|g RN~ |Number [~ |Nan ~|Nan - |student [~ |Date [~|End Dal~|Leve ~|n [~]|calendar ~|men[~ |y Le{~|ion [+]504 Plan [~]stat{~ | vouth
134/040404 036666 1232464211 Last First JD0268488 20180701 20190512 KG  HA  040404-036666-KG-HA * N o N * N
135/040404 036666 1232464212 Last First JD0268488 20190513 20190513 KG  **  040404-036666-KG-"* * N oo N * N
136/040404 036666 1232464215 Last First VJ6624628 20180701 20180701 05 DN 040404-036666-05-DN = N = N = N
137040404 036666 1232464216 Last  First FL2622046 20180701 20180702 01 **  040404-036666-01-* = N = N = N
DN 040404-036666-04-DN = N = N = N
In the cell below the concatenated |- wowsomsmsos ST
DN 040404-036666-01-DN N N 10 N N N
HP  040404-036666-KG-HP N N 05 N N N
data column, paste the data from :
DN 0404 caiibi -[11 < a4 G- 0 BN 10 N N
A ML 0404 — o o N 08 N - N
the Calendar Display report e eI A-E-way B i
ST 1
146 % Ccut
147 By Copy
148 ‘L Paste Options:
149 o o o o, o o
150 0 oy LA 128 13 e
151 Paste Special... »
152
153
154
EMIS
w
e 69
Alliance
Conditional matti
~ Conditional Formatting
|
| IR p T SHIGETTATDUTeS trTectve ave-wecorrUy Y - Gice!
‘ HOME  INSERT  PAGELAYOUT  FORMULAS  DATA  REVIEW  VIEW
¥, Cu =
i, o Calibri | A A »-  EWepied General 8ad Good N
3 Copy -
Pl ol Pikitia Iy- R T LR Merge&iCenter = § = % * ‘8.3 Input
Cupboard . ant s Allgnment ;
Greates Than_
X1 ~ fe | calendar
Less Than_
A | B D E F G H 1 ) R s
State Elpuee » | B Between
Equiva Atten 155 Limited
EMIS Effective lent  dance B Color Scales , Equal To. m English Mig
District Buildin StudentiD Last First State Start  Effective Grade Patter = Proficie nt
1 [IRN [~ gIRN - |Number [~ |Nan ~|Nan ~ |Student | - Date [~ |End Da|~|Leve ~|n |~ |Calendar okt 2 Fext that Contaims. L7Iney_[=]stat
134/040404 036666 1232464211 Last  First JDOZ68483 20180701 20190512 KG  HA  |040404-036666-KG-HA ab L N
135/040404 036666 1232464212 Last  First JDO268483 20150513 20190513 KG  **  |040404-036666-KG-** _— L N
136040404 036666 1232464215 Last  First V6624628 20180701 20180701 05 DN [040404-036666-05-DN . | B S T N N
137/03040 036666 1232064216 Last  First FL2622046 20180701 20180702 01  **  |040404-036666-01-* L N
138{040404 035666 1232464217 Last  First XZ6835408 20180701 00000000 04 DN  [040404-036665-04-ON N N
139/040404 036666 1232064219 Last  First XB0284222 20180701 00000000 03  **  |040404-036666-03-** N | ~— N N
140[040404 036666 1232464234 Last  First 216424448 20180701 00000000 01 DN [040404-036666-01-DN - -
141040404 036566 1232464249 Last  First NN6084222 20180701 20190512 KG  HP  |040404-036665-KG-HP P
182040404 036666 1232464260 Last  First TP2260000 20190107 00000000 03 DN  |040404-036666-03-DN Se|eCt column Contalnlng calendar
143040404 036666 1232464329 Last  First PRS262048 20181113 00000000 02 ML  |040404-036666-02-ML
1841040404 036666 1232464521 Last  First TL2660648 20151029 20150419 05 ML  |040404-036666-05-Mi d h f h b I
prte ata, then from the Home tab, select
136 040403-001111-02- “« g . » s A
11 osoi0scon11.02 Conditional Formatting”, “Highlight
188 040403-001111-04-*
149 040404-001111-05-** I I I ” h “u I 1 I ”
1 o g Cell Rules”, then “Duplicate Values
EMIS
b L
U
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Conditional Formatting, cont’d

- T & - ——r ——
HOME  INSERT  PAGELAVOUT  FORMULAS  DATA  REVEW  VIEW
i !f“" Calbei Ju e = ©- [Eilmpie Genent . Fl [ [nomal Bad Good
e g comrss | L~ 4 @4E ElMeeacoin - <% 0 38 Cntdend ot
K1 - Jx | catendar
A B o E F G H 1 J K L M N o P Q R]
State
Equiva Atten Presch Disabil Student Homeless Limit|
EMIS Effective lent  dance Disadv ool ity being Homel Unaccom Engli:
[District Buildin Student ID Last  First State Start Effective Grade Patter antage Povert Condit served by a ess panied Profi
1 firn [+ g RN~ | Number |~ |Nan v |Nan ¥ |student | ~|Date | ]End Da|*|Leve v |n [~ |calendar ~ |men = |y Lev = |ion [~|504 pian = |stat(~|vouth [+ |ncy
040404 036666 1232464211 Last  First JDO268488 20180701 20190512 KG HA 040404-036666-XG-HA » N 01 N s N L
135/040404 036666 1232464212 Last First JDO26B4S8 20190513 20190513 KG "= ((MOAOM-036666-KG-"* 3 N 0 N . N L
. . DN mmm " N . N d
nad D40404-036666-01-* ol .
Duplicate values will be | ; [eseseas S DY I click OK
h, hl, ht d . . k ** |D40404-036666-03-% . N N
DN 040404-036666-01-DN L N N 2 N
Ig Ig e In pln HP 040404-036666-KG-HP Duplicate Values N
55 TEI A TS0 et i DN |040404-036666-03-DN P — = N
143]040404 036666 1232454329 Last  First ML |040404-036666-02-ML ¥
L |040404-036666-05-ML Bl v | vaiues witn | Ugnt Red Fil witn Dark e Tt ]| | N
H H H H 040404-001111-01-**
Cells highlighted in pink [t
- - - e T—
040404-001111-08.""
indicate a matching calendar | [oeones
- - 040404-001111-KG-HA
in the calendar collection for | |reswscn
040404-001111-KG-WC
. 040404-008888-01-**
calendar assigned to the o custesa -
040404-008888-03-
student e e
8 % 71
U

Alliance

Filter for Mismatches

I oo msmr o pacruoUT  FoeMwLAs | DATA | VW VIEW

[ connecticee T coear N ol
T Reapp N
Fiter Tetto Flash Remove  Daa G
: Voidanied  Columns il Dupficates Validation =

A ] [+ E E [: H I ! K
State
Equiva Atten
EMIS Etfactive lent  dance
District Bulldin Student 1D Last  First  State start  Effective Grade Patter

1 RN [~ | ginm - | nurnbser | - | nan - | Nan - | Student | - [ Date | - End D - [Leve - |n |- | Cabendar
193 040404 033333 1732467897 Last  First  TOGEJRIGG I0IBOTOL 00000OOO 0 DI F) g z
LFIMABINEE Last  First 20180701 20181207 07
1232463214 Last  First  VXSIB54B8 201B0701 00000000 06
173464058 Last  Finst  VBASAD266 J0190415 00000000 07
1232954136 Last Pt TLEA24500 20180236 00000OOD 0%

|

ST Herreer e

150 040404 036666
160 040404 036666
200 040400 036666
201 DA 036666
202 040404 036666
203 040400 036666
204 DA 036666
205 040404 036666

12324642110 Last
1133464315 Last
1232964217 Last
1232464234 Last
1232464249 Last
1232964380 Last
1232464329 Last
1232464520 Last

First
First
First
First
First
First
First
First

D088
WIBEMEIR
AIRRERA0E
ILEA244E
NNB0B4ZEE
TRI260000
FRE26ZME
TL2GG064E

2010701 20190512 KG
20180701 30180701 05
20180701 00000000 04
20180701 00000000 01
20180700 20190512 K6 HI
20180107 00000000 03 O
201B1113 00000000 02 L
BI0FS 0190415 05 M

[Select AN

40404 20111117
40404 00111101 D
040404201111 025
040404 20111102,
40404 DOL1L 3.2
040404.001111-03-0
040404 201111037
40404 D0L11104. 00

Cancel

040404-019034- KG- B
(20404-032422-01-**

Click on the filter in the
column containing
concatenated data then
select “Filter by Color”,
then “No Fill”

-

U
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Troubleshoot the data

B A S "2 @ s SIGdent AMEUTEs Emecve-meTe-rerora-{FUT [OTXI - Eicel
FLE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
1 : ] Connect 7T W Y Clear
& > . :
from From F resh Sort | Filter date What-If Group Ungroup Sul
Access Web T All = Vo Advanced nalys - B
X231 - Je
B 1 P Q
State
Equiva Atten Presch Disabil Student Homeless Lim|
EMIS Effective lent dance Disadv ool ity being Homel Unaccom Eng
District Buildin StudentID Last First State Start Effective Grade Patter antage Povert Condit servedbya ess panied  Pro
1 IRN [~]gIRN v |Number [~ |Nan ~|Nan ~ | student | ~|Date |~ |EndDal ~|Leve *|n [+|calendar | men ~ |y e\~ Jion [+]|s04plan [~ ]stat{~ |vouth [*|ney
199/040404 036666 1232464215 Last  First VI6624628 20180701 20180701 05 DN  040404-036666-05-DN : a = m : A A
200 040404 036666 1232464217 Last First XZ6886408 20180701 00000000 03 DN  040404-036666-04-DN .
201040404 036666 1232464234 Last First ZL6424448 20150701 00000000 01 DN  040404-036666-01-DN StUdents WlthOUt Calendars
202/040404 036666 1232464249 Last  First NNG0S84222 20180701 20190512 KG  HP  040404-036666-KG-HP p=t . .
203 040404 036666 1232464280 Last  First TP2260000 20150107 00000000 03 DN  040404-036666-03-DN in the Calendar Collectlon
204040404 036666 1232464329 Last  First PR8262048 20181113 00000000 02 ML 0404 2-ML
205/040404 036666 1232464521 Last  First TL2660648 20181029 20190419 05 ML _040404-036666-05-ML 1 N 08 N . N N
206 040404-008888-03-WC
207 R 040404-019034-01-ML
08 Calendars with no students | | cwwsommonuc
209 T 040404-019034-03-WC
3 : e
20 in the student collection 03044 015004-04
m 040404-019034-05-ML
12 040403-019034-KG-HA
EMIS
\ .
T 73
Alliance

. Troubleshoot the data
Why do students not have a matching calendar?
| * |s there something preventing a calendar from being reported, or is
there no matching calendar being reported?
* If yes, fix or create a matching calendar in the SIS and submit it to EMIS
* Is the student on a calendar that is not reportable to EMIS?
* If yes, ignore the mismatch
* Does the student match to a calendar based on a wildcard grade level?

* Grade level ** in the calendar collection is a wildcard
* Example - District IRN-Building IRN-01-** matches to District IRN-Building IRN-

*ok_k ok

* Match these students and calendars manually

* Check your FTE Detail Report to verify that students are being correctly
assigned to calendars through the calendar determination process

EMIS

\ A ) A
- -'},;‘3‘;: w4
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Troubleshoot the data, cont’d

Why are there calendars with no students?

* Typically okay to report calendars with no students just be careful
if the unused calendar has a start date that is before your district’s
earliest calendar or an end date that is after your latest calendar
as this could effect some of the checks that EMIS uses such as
separated staff and summer graduates

* The early start date issue can be found for any calendar in the
calendar collection whether it is used for students or not

* Consider not reporting unused calendars to EMIS

EMIS
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Quick Check * Are you able to perform concatenation
Calendar verification is very and conditional formatting?
important since there are no * Do you have students with no calendar

checks in EMIS between the
student collections and the
calendar collections. This * Do you have calendars reported to
exercise will allow for a very EMIS with no students assigned?
quick comparison to identify

EMIS reporting issues.

in the calendar collection?

EMIS
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Summary

* Basic Excel techniques can be very useful when
troubleshooting
* EMIS data in the Student Information System
* EMIS reports
* preview/review files

* These techniques should be part of your everyday practices

EMIS
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Resources

* Microsoft Excel Help within Excel “?” Articles and Videos
* Google it

* Microsoft Excel Classes

* Your ITC

EMIS Alliance
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Questions?
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